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BYEE : RNMENHE T EBRERBIDNSER, BEFERWCCPE FimERL

S B 1. & AZIFMC GUI , AR EM F|Object > Object Management > Access List > Extended >
Add Extended Access List,
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NEVHRBFENEEAQFEAERE , ARMERT



Edit Extended Access List Object

Name

I Redirect_traffic

Entries (3)

& Bl S i S o
2 X LAN S E
u

Allow Overrides

MizE : L EEUSE M RAREEFRWCCPE A EREAFTDA R ER Action Block , LLUE%
BB EE,



sk | BRI BAfE A Action Blocki 2 5 —%FEA , AERAHEH BN BAFTSEEIN
E RS,

REFEULAAFTREER[EProxyRFHNATE AR E.

)RV HREFEURBWCCPEFin , A®IE— T Save,

Name

[ weee-cuenT
Entries (1)
1 All WSh_s s
Allow Overrides

AREBWCCPEFinkIFIEBE
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Edit Text Object T

Mame:

Description:
Variable Type Count
Single v 1
1 a7

|| Allow Overrides

| Cancel | Save

EREETweep RIEH R



BEE : HUL RGP, RIBIDAI7. BEBREFENNOMI7 2 EHRKID , HAELRIEIDE
FRIERBERENHMRBIDFER,

ARFMEN , FSRASALHWCCP S, REIFAEE

SER 3

- EE F0Object > Object Management > FlexConfig > Text Object , R#&ES
isServiceldentifer,

Text Object ['\"« isServiceldentifier] %

Text objects define free-form text strings that you use as variables in a FlexConfig object. These objects can have single values or be a list of multiple values

 #&isServiceldentiferftfalsef&ek Btrueo


https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html

« isServiceldentifer - 1R Afalse , Blf# Fstandardweb-cacheserviceid Bl 5%, a2
FirepowerEEH OB EISE

Edit Text Object @

Name:

iIsServiceldentifier

Description:

A flag to identity whether to use
service in wecep.

Variable Type Count
Single - 1 A
1 true

Allow Overrides

» Override (0)

H&E RtfalsefS th Btrue



https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
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Application Filters

AS Path Nam i ' &

BFD Template Woop_ ¢ plate is an example of weep configur... I O,

Cipher Suite Lis

» Community List

DHCP IPvE Pool
» Distinguished Name
Group
» External Attributes
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* FlexConfig
FlexConfg Object
Text Object

MiZE : FlexConfigli REBFEEZ AR : Weep_Configure, FEEASERMMBIEE, &
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« RE=1TMIBRSserviceldentifier 28 , WIRHFEEECSHWEE,

Add FlexConfig Object
Name:

Weep_Configure_clone
Description:

The template is an example of

weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert » | Deployment: Once v Type: Append
#set{ $service = "web-cache")
#if( $isServiceldentifier == "true")
#set | S$service = "$sepviceldentifier"
Jend —
fset ( SwccpCli = "wecp”)
#set ( SwoepCli = "SweepCli $service")

#end
###fweccpRedirectlist is place-holder for extended ACL.
####Replace pRedirectlList with extended ACL defined in FMC by inserting policy-object of type extended ACL.
#if{ SwecpRedirectList )
fset | SweepCli = "SweopCli redirect-list $weogpRedirectList™)
fend
¥ Variables
Name Dimension Default Value il Override Description
(Type:Name) P
isServiceldentifier SINGLE true FREEFORM:I... false A flag to determine if service ...
serviceldentifier SINGLE 1 FREEFORM:... false service identifier number is to...

i B AR 745 38 51 45 817

+ #%Text Objectwccp-servicel@ A &L ER2HIE T W EE,
- RTHIEED  EE "HBAL > "TBHARBER, > TXAXRER,




Add FlexConfig Object

Name:

! Wecep_Configure_clone

Description:

. The template is an example of
| wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v . E3 Deployment: ' Once v Type: ' Append

| Insert Policy Object Text Object

Insert System Variable » Network

§

Insert Secret Key Security Zones
#set ( SwecepGli = "Sweg .
####wccpGroupList is pl Standard ACL Object 3 acr.
f###Replace wecepGroupLi afined in FMC by inserting policy-object of type extended ACL.

§if ( $wecpGroupl Extended ACL Object

#set( SwecpCli =

#end Route Map

fend

#&weep-service B RIEBB IR A

« BB Namewccp-services
« 7E£Available Object® # Zwccp-service-objects,

- MTEHRIFHF



Insert Text Object Variable (7]

Variable Name:

| wecep-service ‘

Description:
Available Objects Selected Object
| 2, weep b4 ‘ weep-service-object .

wecepPassword
FiBweep RISE R
FER 6

« BHwccpGroupListZ2REBAREEESNEE,



Add FlexConfig Object

MName:

[ Wecep_Configure_clone l

Description

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

l Insert » s Deployment: | Once v Type: | Append v

#set( $service = "web-cache")

#if( $isServiceldentifier == "true")
#set{ §service = "$wegposervice")
fend

#set ( $wcopCli = "$wccpCll $service")
WCCPGIoup t is place-holder for extended ACL.
####Replace wecpGrouplist with extended ACL defined in FMC by inserting policy-object of type extended ACL.
'——biif{ $weepGrouplist )
#set({ SwoepCli = "$wegpCli group-list SwecpGroupList"™)
#end
#8#8wccpRedirectlis

I BR 78 E 2= MwcepGroupList & 2]

# T HEEInsert > Insert Policy Object > Extended ACL Object.

Name:

| Weep_Configure_clone

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

[ Insert v i i % Deployment: Once v Type: | Append

Il Insert Policy Object Text Object

Insert System Variable »  Network

Insert Secret Key Security Zones

Standard ACL Object i ACL.

:fined in FMC by inserting policy-object of type extended ACL.
Extended ACL Object

¥ Variables

Hi8wcepGrouplistiERACL

Bh L8 £ — SRR E B0 BRI B BweepGroupList.



s ESBMHPETH A HERFEZSWCCP-CLIENT,
« AddFISave®E.

T ey

Variable Name:

‘_ wccepGrouplist l

Description:

Available Objects C
‘ Q Search X‘

L‘Qedirect_traﬂﬁc

“*WCCP-CLIENT

FigwccrE FiniERIBE
SR

- EiEwccpRedirectList AR MR HEB S B R,

Insert Extended Access List Object Variable

Selected Object
HVCCP-CLIENT

o)



Add FlexConfig Object

Name:

( Weep_Configure_clone ]

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v Deployment: I Once v ‘ Type: | Append

#set ( $service = "web-cache")

#if( $isServiceldentifier == "true")
Seng T he S SEEHREEARELAR
#set ( SweepCli = "wecp")

#set ( SweepCli

####Replace )
=——pjif ( $wecpRedirect

#set( SweepCli = "$weecpCli redirect-list $wecpRedirectList™)

#end

MIB&wccpRedirectList

- RTHAREF , BEHACBEARBYR>BERACLAR.

Add FlexConfig Object

Name:

[ Wecep_Configure_clone ]

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v | || Deployment: [ Once v Type: Append

| Insert Policy Object Text Object

Insert System Variable » Network

Insert Secret Key Security Zones
#set [ SWegpCll = "SWeC ;
####wccpGrouplist is pl Standard ACL Object 3 acr.
####Replace wecopGroupLi X fined in FMC by inserting policy-object of type extended ACL.
#E( ) Extended ACL Object
#set ( SwecpCli = "Sweep oupList™)
#end Route Map

###¥wccpRedirectlist is place-nolaer ror extended ACL.
###4Replace weepRedirectList with extended ACL defined in FMC by inserting policy-object of type extended ACL.

#end

¥ Variables

AwccpRedirectListiZIZERACLE R

- EE8EE P EwecpRedirectLists



- ET ¥R+ FRedirect_traffico
- #{EAJdISave,

e el eileeiliaeosiisisaiiisisisiiisneiios e = = e e e e

Insert Extended Access List Object Variable @

Variable Name:

‘ wccpRedirectList ‘

Description:

Available Objects C Selected Object
‘ Q_ Search p 4 Lﬁzeorjirect_traﬁ“lc

£ Redirect_traffic

#VCCP-CLIENT

)

#¥8Redirect_traffic ACL

SER 8:

o fHIER@wccpPassword



Add FlexConfig Object

Name:

[ Wecep_Configure_clone ‘

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

| Insert v

3 Deployment: [ Once v | Type: [ Append v

FMC by inserting policy-object of type extended ACL.

t is place-holder for extended ACL.
irectList with extended ACL defined in FMC by inserting policy-cbject of type extended ACL.

#foreach( $interfaceName in $security-zone)

2 M ERFEE Z M wecppassword

« RIBASTEA L8 (Insert > Insert Secret Key) FHLIREHiRIZSEE,

Add FlexConfig Object

Name:

Wecep_Configure_clone ‘

Description:

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

‘. Insert v . E2 Deployment: l Once A l Type: l Append

)
Insert Policy Obiect » ace-holder for extended ACL.
Y g st with extended ACL defined in FMC by inserting policy-object of type extended ACL.

Insert System Variable » . . .
Y Cli group-list S$weepGroupList™)

Insert Secret Ke
place-holder for extended ACL.

####Replace weccpRedirectList with extended ACL defined in FMC by inserting policy-object of type extended ACL.

#foreach({ $interfaceName in $security-zone)

¥ Variables

« #&—T TAdd Secret Key. o



Insert Secret Key @

Add Secret Key

Name

~,
«

[ ] wccpPassword

Cancel Save

HIBER

- EEREBPAAZRE,
. BRI,
« fEConfirm PasswordF ¥ A MBIV 215 , AR KL —TAdd,



Add Secret Key

Secret Key name:*

‘ wccpPassword

Password:*

HIBEREERNER

[ Cancel ’

Add




Mt - EARGIH , REBTEBR B Security Zone in,

SR
- BRFEEZRMWsecurity-zone , A $security-zone BB EEHSHWEH,



Edit FlexConfig Object

Name:

| Weep_Configure_clone |

Description:

The template is an example of
weep configuration. It can not

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Deployment: | Once

fforeach( $interfaceName in $SECUrity-ZONe |
weep interface $interfaceName §service redireet in

fend
* \ariables
Name Dimension
wcepGrouplist SINGLE
wcecp-service SINGLE
interfaceName SINGLE
security-zone SINGLE
EH EZMWsecurity-zone

Default Value

WCCP-CLIENT

97

in

in

Property
(Type:Name)

EXD_ACL:W...
FREEFORM:...
SECURITYZ...

SECURITYZ...

v | Type: | Append

Override

false

false

false

false

Description

o T HLEEHIEESecurity Zones , A& i1EEInsert > Insert Policy Object,



Add FlexConfig Object

Name:

Wecep_Configure_clone

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert B2 Deployment: I Once v ‘ Type: I Append

Insert Policy Object Text Object supList™)

Insert System Variable »  Network wded ACL.
. defined in FMC by inserting peolicy-object of type extended ACL.
Insert Secret Key Security Zones
¥5eT| PWCCPULL = “3»WCCE JRedirectList")
$end Standard ACL Object

#set ( SwcepCli = "Swecp Extended ACL Object vord ")
$WecpCli Route Map

#### Assiging wccp onto interface
#foreach( in $security-zone)

#end
¥ Variables
BERZESE

- BB F WAL £ Bsecurity-zone
- f£Available Objects¥ , EEEFIEH N E,
- ¥&—T TSave, ,



Insert Security Zone Variable (7]

Variable Name:

| security-zone |

Description:

Available Objects Selected Object
| C, Search ‘ in

o/

dmz

out

Cancel Save

gLz EE
SE10:

- BB FDevices > FlexConfig , #&— T New Policy X Edit}a 5 KB
- EIZEHE B M Wcep_configure_clonei R |, REKE—T>ETHE,
- ¥&—T TSave, ,



MiEE : BAETRR  FRAKRKBIEGFTDRE. HRBRERK  LES I EAEMK,

WCCP_config

B115  BRINE-REFTDRE>FHERE,



e
TR 1REBETEE.
E AFTD CLI3f 347 @5 45 show running-config wecpo

REET I

wccp 97 redirect-1ist Redirect_traffic group-Tist WCCP-CLIENT password ###*%*%*
wccp interface inside 97 redirect in

ERAREEFERNER  FETHT.
1) system support diagnostic-cli

2) enable

3) T A R IFREnterii

4) more system:running-config | include wecp

S ER 2: R FBWCCPHRAE

ﬂ?ﬁ%mwmm

Global WCCP information:
Router information:
Router Identifier: -not yet determined-
Protocol Version: 2.0

Service Identifier: 97

Number of Cache Engines: 1

Number of routers: 2

Total Packets Redirected: 0

Redirect access-1ist: Redirect_traffic
Total Connections Denied Redirect: 0

Total Packets Unassigned: 0

Group access-Tist: WCCP-CLIENT
Total Messages Denied to Group: 0

Total Authentication failures: 0

Total Bypassed Packets Received: 0

#1Te 5 show weep 97 service

WCCP service information definition:



Type: Dynamic

Id: 97
Priority: 240
Protocol: 6
Options: 0x00000012
Hash: DstIP
A1t Hash: -none-
Ports: Destination:: 80 443 000000

BYEE : SBEI7TRIRIFID, MR AEEPEIRWCCPEFimE AR : #7,

3) Run the command show wcep 97 view
SR BT AR
SR 1 HEEFTDEARARNKE A RF[EWWCCPERWMEE N HEAIEE M,



EAEH P , REEHEG Elthedmz/ T H.

>show route
S 10.xx.xx.xx 255.yyy.yyy.yyy [1/0] via 10.zz.zz.z, dmz

MIEE : BEBR10.xx.xx.xx 2R EMARESIP , 255.yyy.yyy.yyy=Netmask , 10.zz.zz.z2 T —Bk
WA,

SR 2:FinsidefMldmz/ M H L EVEHEE , LBERAREEFHEMN,
HEIB443M RSN E LT

capture capinside interface inside trace detail match tcp any any eq 443



FEdmz T H EREER :

capture capdmz interface dmz trace detail match gre any any

MEE . EdmztE L , XEFEHAGREBABEETRE. EFEQHISHELEGREHS
F, EifwccpE R &,

S BB 3:¢H ¥ weepH{ESE
EfTws
debug weep event debu weep packet

212 HiCisco#f FRIDCSCvn90518 , AR BRINEE , LIEAWCCPE ERHFDMAFMCA#IE K 32
=,



https://tools.cisco.com/bugsearch/bug/CSCvn90518
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